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1—Информация о принтере 
Использование панели управления принтера 

Используется Для 

1 Дисплей • Просмотр состояния принтера и сообщений.

• Настройка и работа принтера.

2 Кнопки со стрелками Прокрутка вверх-вниз и влево-вправо. 

3 Кнопка выбора • Выбор опций меню.

• Сохранение настроек.

4 Кнопка "Адресная книга" Просмотр всех сохраненных адресов. 

5 Кнопка повторного набора Просмотр последнего набранного номера. 

6 Клавиатура Ввод цифр, букв или символов. 

7 Кнопка перехода в режим ожидания Включение режима ожидания или гибернации. 

Для того, чтобы вывести принтер из режима 
ожидания, проделайте следующее: 

• Нажмите  (кнопку перехода в режим 
ожидания).

• Отправьте с компьютера задание на печать.

• С помощью главного выключателя питания
выполните сброс при включении питания.

• Примите факс.

8 Кнопка "Отмена" Отмена всех операций принтера. 

9 Кнопка "Старт" Запуск задания, в зависимости от выбранного 
режима. 
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Используется Для 

10 Кнопка факса Отправка факсов. 

11 Кнопка возврата Возврат к предыдущему окну. 

12 Кнопка "Главное окно" Переход к главному окну. 

13 Индикаторная лампа Проверка состояния принтера. 

Значение цветов кнопки перехода в режим ожидания и 
световых индикаторов 
Цвета кнопки перехода в режим ожидания и световых индикаторов на панели управления 
принтером означают определенное состояние принтера. 

Цвет индикатора и соответствующее состояние принтера 

Индикатор Состояние принтера 

Не горит Принтер выключен или находится в спящем режиме. 

Мигает зеленым Принтер нагревается, обрабатывает данные или печатает. 

Горит зеленым Принтер включен, но не работает. 

Мигает красным Принтер требует вмешательства пользователя. 

Цвет кнопки перехода в режим ожидания и соответствующее состояние принтера 

Кнопка перехода в режим ожидания Состояние принтера 

Не горит Принтер выключен, находится в режиме ожидания или в состоянии 
готовности. 

Горит желтым Принтер находится в режиме ожидания. 

Мигает желтым Принтер входит в спящий режим либо выходит из него. 

Мигает желтым в течение 0,1 секунды, 
затем не горит 1,9 секунды 
(медленное, пульсирующее мигание) 

Принтер находится в спящем режиме. 
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2—Загрузка бумаги и специальных 
носителей 
Настройка формата и типа бумаги 
1. На панели управления принтера перейдите к: 

 >Settings >  >Paper Menu >  >Paper Size/Type >  

2. Нажмите кнопку со стрелкой вверх или вниз, чтобы выбрать лоток или податчик, и 

нажмите . 

3. Нажмите кнопку со стрелкой вверх или вниз, чтобы выбрать формат бумаги, и нажмите . 

4. Нажмите кнопку со стрелкой вверх или вниз, чтобы выбрать тип бумаги, и нажмите , чтобы 
изменить настройки. 

Конфигурирование универсальных настроек бумаги 
Универсальный формат бумаги - это пользовательская настройка, позволяющая печатать на 
бумаге формата, отсутствующего в меню принтера. 

Примечания: 

• Минимальный поддерживаемый универсальный формат - 76,2 x 127 мм (3 x 5 дюймов), 
поддерживается только универсальным податчиком. 

• Максимальный поддерживаемый универсальный формат 215,9 x 355,6 мм (8.5 x 14 дюймов), 
поддерживается всеми источниками бумаги. 

1. На панели управления принтера перейдите к: 

 >Settings >  >Paper Menu >  >Universal Setup >  >Units of Measure >  > 

выберите единицу измерения >  

2. Выберите Portrait Width или Portrait Height, и нажмите . 

3. Для изменения настройки нажмите кнопку со стрелкой влево или вправо, затем нажмите . 

Загрузка лотков 

 ПРЕДОСТЕРЕЖЕНИЕ—ВОЗМОЖНОСТЬ ТРАВМ: для снижения риска нестабильности 
оборудования загружайте каждый лоток по отдельности. Пока не возникнет необходимость, 
держите все остальные лотки закрытыми. 
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1. Полностью выдвиньте лоток. 

Примечание: не вынимайте лотки, если на дисплее принтера отображается Busy или 
выполняется задание на печать. Это может привести к застреванию бумаги. 

 

2. Сожмите и затем сдвиньте защелку поперечной направляющей в нужное положение, 
соответствующее формату загружаемой бумаги. 
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3. Сожмите и затем сдвиньте защелку продольной направляющей в нужное положение, 
соответствующее формату загружаемой бумаги. 

 

Примечания: 

- Для некоторых форматов бумаги (например, Letter, Legal и A4) сожмите и сдвиньте 
защелку продольной направляющей назад в соответствии с длиной бумаги. 

- При загрузке бумаги формата Legal продольная направляющая выдвигается за пределы 
корпуса, вследствие чего на бумагу может попадать пыль. Чтобы предотвратить попадание 
пыли, необходимо отдельно приобрести пылезащитную крышку. Для получения 
дополнительной информации обратитесь в техническую поддержку. 

- При загрузке бумаги формата A6 в обычный лоток сожмите и затем сдвиньте защелку 
продольной направляющей по направлению к центру лотка к положению, 
соответствующему формату A6. 

- Проверьте, что положение продольной и поперечной направляющих совпадает с 
индикаторами формата бумаги в нижней части лотка. 
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4. Изогните листы вперед и назад, чтобы предотвратить слипание, а затем пролистайте. Не
складывайте и не мните бумагу. Подровняйте края на ровной поверхности.

5. Загрузите стопку бумагу.

Примечания: 

- При загрузке переработанной бумаги или бумаги, на которой уже выполнялась печать, 
загружайте ее отпечатанной стороной вниз. 
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- Перфорированную бумагу загружайте так, чтобы отверстия располагались по верхнему 
краю по направлению к передней части лотка. 

- Бланки писем загружайте лицевой стороной вниз, верхним краем листа по направлению к 
передней части лотка. При двусторонней печати бланки писем загружайте лицевой 
стороной вверх по направлению к передней части лотка. 

- Убедитесь, что бумага не превышает индикатора максимальной загрузки, расположенного 
сбоку поперечной направляющей. 

 

6. Вставьте лоток. 
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7. На панели управления принтера в меню "Paper" задайте формат и тип бумаги, 
соответствующий бумаге, загруженной в лоток. 

Примечание: для предотвращения застревания бумаги и возникновения проблем с качеством 
печати задавайте правильные тип и формат бумаги. 

Загрузка многофункционального податчика 
Многофункциональный податчик используется при печати на бумаге разных форматов и типов, а 
также специальных носителях (например, стопка карточек, прозрачные пленки и конверты). Он 
также может использоваться для печати бланков писем на одной странице. 

1. Откройте многофункциональный податчик. 

 

a. Вытяните удлинитель многофункционального податчика. 
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b. Аккуратно вытягивайте удлинитель, чтобы многофункциональный податчик был полностью 
выдвинут и открыт. 

 

2. Сожмите защелку на левой поперечной направляющей и переместите направляющие в 
соответствии с загружаемой бумагой. 

 

3. Подготовьте для загрузки бумагу или специальный носитель. 

- Изогните листы бумаги вперед и назад, чтобы предотвратить слипание, а затем 
пролистайте. Не складывайте и не мните бумагу. Подровняйте края на ровной поверхности. 

 

13

копиры��— �принтеры��— �мфу доставка��—�сервис��—�гарантия info@km-shop.ru www.km-shop.ru(495) 646-04-26



Краткое руководство 

 
- 14 - 

- Прозрачные пленки держите за край. Изогните листы прозрачной пленки вперед и назад, 
чтобы предотвратить слипание, а затем пролистайте. Подровняйте края на ровной 
поверхности. 

Примечание: не касайтесь той стороны прозрачной пленки, на которой выполняется 
печать. Будьте осторожны и не поцарапайте пленки. 

 

- Изогните конверты вперед и назад, чтобы предотвратить слипание, а затем пролистайте. 
Подровняйте края на ровной поверхности. 

 

4. Загрузите бумагу или специальный носитель. 

Примечания: 

- Не проталкивайте бумагу или специальный носитель в многофункциональный податчик. 

- Убедитесь, что бумага или специальный носитель не превышают индикатора 
максимальной загрузки, расположенного сбоку поперечной направляющей. Переполнение 
может вызвать застревание бумаги. 
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- Бумагу, прозрачные пленки и стопки карточек загружайте стороной для печати вверх, 
чтобы сначала в принтер попадал верхний край листа. Дополнительную информацию о 
загрузке прозрачных пленок см. на упаковке, в которой поставляется пленка. 

 
 

  

Примечание: при загрузке бумаги формата A6 убедитесь, что удлинитель 
многофункционального податчика немного упирается в край бумаги, чтобы последние 
несколько листов бумаги оставались на месте. 
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- Бланки писем загружайте лицевой стороной вверх, чтобы сначала в принтер попадал 
верхний край листа. При двусторонней (дуплексной) печати бланки писем загружайте 
лицевой стороной вниз, чтобы сначала в принтер попадал нижний край листа. 

 

- Конверты с клапаном с левой стороны загружайте лицом вниз. 

 

Предупреждение. Возможность повреждения: никогда не используйте конверты с 
марками, застежками, кнопками, окошками, защитным покрытием или самоклеющимися 
участками. Такие конверты могут серьезно повредить принтер. 

5. На панели управления принтера в меню "Paper" задайте формат и тип бумаги, 
соответствующий бумаге или специальному носителю, загруженному в многофункциональный 
податчик. 
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Связывание и отмена связывания лотков 

Связывание и отмена связывания лотков 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера.

Примечания:

- Посмотрите IP-адрес принтера на панели управления принтером в разделе TCP/IP меню
"Network/Ports". IP-адрес отображается в виде четырех наборов цифр, разделенных 
точками, например 123.123.123.123. 

- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings >Paper Menu.

3. Измените настройки формата и типа бумаги для связываемых лотков.

- При связывании лотков проверьте, что тип и формат бумаги обоих лотков совпадают.

- При отмене связывания лотков проверьте, что тип и формат бумаги обоих лотков не
совпадают. 

4. Нажмите Submit.

Примечание: настройки формата и типа бумаги также можно изменить с панели управления 
принтера. Для получения дополнительной информации см. Настройка формата и типа бумаги. 

Предупреждение. Возможность повреждения: загруженная в лоток бумага должна 
соответствовать названию типа бумаги, присвоенному в принтере. В зависимости от заданного 
типа бумаги температура узла термозакрепления может различаться. Если настройки были 
сконфигурированы неправильно, то могут возникнуть проблемы при печати. 

Создание пользовательского имени для типа бумаги 

Использование встроенного веб-сервера 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера.

Примечания:

- Посмотрите IP-адрес принтера в разделе TCP/IP меню "Network/Ports". IP-адрес
отображается в виде четырех наборов цифр, разделенных точками, например 
123.123.123.123. 

- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings >Paper Menu >Custom Names.

3. Выберите пользовательское имя и введите новое имя пользовательского типа бумаги.

4. Нажмите Submit.
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5. Нажмите Custom Types и проверьте, заменило ли имя нового пользовательского типа бумаги
пользовательское имя.

Использование панели управления принтера 

1. На панели управления принтера перейдите к:

 >Settings >  >Paper Menu >  >Custom Names 

2. Выберите пользовательское имя и введите новое имя пользовательского типа бумаги.

3. Нажмите . 

4. Нажмите Custom Types и проверьте, заменило ли новое имя нового пользовательского типа
бумаги прежнее имя.

Присвоение имени пользовательскому типу бумаги 

Использование встроенного веб-сервера 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера.

Примечания:

- Посмотрите IP-адрес принтера в разделе TCP/IP меню "Network/Ports". IP-адрес
отображается в виде четырех наборов цифр, разделенных точками, например 
123.123.123.123. 

- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings >Paper Menu >Custom Names.

3. Введите имя для типа бумаги и нажмите Submit.

4. Выберите свой тип бумаги и проверьте, чтобы пользовательскому имени был сопоставлен
правильный тип бумаги.

Примечание: "Обычная бумага" - это заданный по умолчанию тип бумаги для всех
пользовательских имен.

Использование панели управления принтера 

1. На панели управления принтера перейдите к:

 >Settings >  >Paper Menu >  >Custom Names 

2. Введите имя для типа бумаги и нажмите . 
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Назначение пользовательского типа бумаги 

Использование встроенного веб-сервера 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера. 

Примечания: 

- Посмотрите IP-адрес принтера в разделе TCP/IP меню "Network/Ports". IP-адрес 
отображается в виде четырех наборов цифр, разделенных точками, например 
123.123.123.123. 

- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings >Paper Menu >Custom Types. 

3. Выберите имя пользовательского типа бумаги, затем выберите тип бумаги. 

Примечание: "Бумага" - это заданный по умолчанию тип бумаги для всех указанных 
пользователем пользовательских имен. 

4. Нажмите Submit. 

Использование панели управления принтера 

1. На панели управления принтера перейдите к: 

 >Settings >  >Paper Menu >  >Custom Types 

2. Выберите имя пользовательского типа бумаги, затем выберите тип бумаги. 

Примечание: "Бумага" - это заданный по умолчанию тип бумаги для всех указанных 
пользователем пользовательских имен. 

3. Нажмите . 
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3—Печать 
Печать документа 

Печать документа 

1. На панели управления принтера в меню "Paper" задайте формат и тип бумаги,
соответствующий загруженной бумаге.

2. Отправьте задание на печать:

Для пользователей Windows

a. Когда документ открыт, нажмите File >Print.

b. Нажмите Properties, Preferences, Options или Setup.

c. При необходимости задайте настройки.

d. Нажмите OK >Print.

Примечание: подробнее о настройках свойств печати см. в справке драйвера. 
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Для пользователей Macintosh 

a. При необходимости задайте настройки в диалоговом окне "Page Setup": 

1. Когда документ открыт, нажмите File >Page Setup. 

2. Выберите формат бумаги или создайте пользовательский формат, соответствующий 
загруженной бумаге. 

3. Нажмите OK. 

b. При необходимости задайте настройки в диалоговом окне "Page Setup": 

1. Когда документ открыт, нажмите File >Print. 

Чтобы увидеть дополнительные опции, щелкните скрывающий их треугольник. 

2. При необходимости задайте настройки в диалоговом окне "Print" и всплывающих меню. 

Примечание: для печати на бумаге определенного типа задайте настройку типа 
бумаги, совпадающего с загруженной бумагой, или выберите соответствующий лоток 
или податчик. 

3. Нажмите Print. 

Регулировка плотности тонера 

Использование встроенного веб-сервера 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера. 

Примечания: 

- Посмотрите IP-адрес принтера в разделе TCP/IP меню "Network/Ports". IP-адрес 
отображается в виде четырех наборов цифр, разделенных точками, например 
123.123.123.123. 

- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings >Print Settings >Quality Menu >Toner Darkness. 

3. Отрегулируйте плотность тонера и нажмите Submit. 

Использование панели управления принтера 

1. На панели управления принтера перейдите к: 

 >Settings >  >Print Settings >  >Quality Menu >  >Toner Darkness 

2. Отрегулируйте плотность тонера и нажмите . 
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Отмена задания на печать 

Отмена задания на печать с панели управления принтера 

На панели управления принтера нажмите . Когда появится список заданий печати, выберите 

задание, которое требуется отменить, и нажмите . 

Отмена задания на печать с компьютера 

Для пользователей Windows 

1. Откройте папку "Принтеры". 

В Windows 8 

Нажмите кнопку "Поиск", введите run и перейдите к: 

Список приложений >Выполнить > введите control printers >OK 

В Windows 7 и предыдущих версиях 

a. Нажмите  или Пуск, затем нажмите Выполнить. 

b. В диалоговом окне "Начать поиск" или "Выполнить" введите control printers. 

c. Нажмите Ввод или OK. 

2. Дважды щелкните по пиктограмме принтера. 

3. Выберите задание на печать, которое необходимо отменить. 

4. Нажмите Удалить. 

Для пользователей Macintosh 

1. В меню Apple перейдите к одному из перечисленных пунктов: 

- (Для Mac OS X v10.3/v10.4/v10.5/v10.6)  
System Preferences >Print & Fax > выберите принтер >Open Print Queue 

- (Для Mac OS X v10.7/10.8) 
System Preferences >Print & Scan > выберите принтер >Open Print Queue 

2. В окне принтера выберите задание на печать, которое необходимо отменить, и удалите его. 
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4—Копирование 
Изготовление копий 

Изготовление "быстрой копии" 

1. Загрузите оригинальный документ лицевой стороной вверх, короткой стороной вперед в лоток 
АПД или лицевой стороной вниз на стекло сканера. 

Примечания: 

- Не загружайте в лоток АПД открытки, фотографии, прозрачные пленки, фотобумагу и 
тонкие носители (например, вырезки из журналов). Размещайте их на стекле сканера. 

- Если бумага загружена правильно, загорается индикатор АПД. 

2. При загрузке документа в лоток АПД отрегулируйте положение направляющих для бумаги. 

Примечание: чтобы изображение не было обрезанным, убедитесь, что формат оригинального 
документа и формат бумаги совпадают. 

3. На панели управления принтера нажмите . 

Копирование с помощью АПД 

1. Загрузите оригинальный документ лицевой стороной вверх, короткой стороной вперед в лоток 
АПД. 

Примечания: 

- Не загружайте в лоток АПД открытки, фотографии, прозрачные пленки, фотобумагу и 
тонкие носители (например, вырезки из журналов). Размещайте их на стекле сканера. 

- Если бумага загружена правильно, загорается индикатор АПД. 

2. Отрегулируйте направляющие бумаги. 

3. На панели управления принтера с клавиатуры введите количество копий и нажмите . 

Копирование с помощью стекла сканера 

1. Положите оригинальный документ в левый верхний угол стекла сканера лицевой стороной 
вниз. 

2. На панели управления принтера с клавиатуры введите количество копий и нажмите . 

Обратите внимание: Если вы хотите отсканировать другой документ, то положите следующий 
документ на стекло сканера, нажмите на кнопку с левой или правой стрелкой для перехода к 

Scan the Next Page, и нажмите . 
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3. Нажмите на кнопку с левой или правой стрелкой для перехода к Finish the Job и 

нажмите . 

Копирование фотографий 
1. Положите фотографию в левый верхний угол стекла сканера лицевой стороной вниз. 

2. На панели управления принтера перейдите к: 

 >Copy >  >Content Type >Photo 

3. В меню "Content Source" выберите настройку, лучше всего описывающую копируемое вами 

оригинальное фото и нажмите . 

Обратите внимание: если вы хотите скопировать другое фото, то положите его на стекло 
сканера, нажмите на кнопку с левой или правой стрелкой для перехода к Scan the Next 

Page и нажмите . 

4. Нажмите на кнопку с левой или правой стрелкой для перехода к Finish the Job и 

нажмите . 

Отмена задания на копирование 

Отмена копирования с панели управления принтера 

На панели управления принтера нажмите . 
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5—Электронная почта 
Настройка принтера для работы с E-mail 

Настройка функции E-mail 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера. 

Примечания: 

- Посмотрите IP-адрес принтера в разделе TCP/IP меню "Network/Ports". IP-адрес 
отображается в виде четырех наборов цифр, разделенных точками, например 
123.123.123.123. 

- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings >E-mail/FTP Settings >E-mail Settings. 

3. Введите необходимую информацию и нажмите Submit. 

Настройка параметров E-mail 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера. 

Примечания: 

- Посмотрите IP-адрес принтера в разделе TCP/IP меню "Network/Ports". IP-адрес 
отображается в виде четырех наборов цифр, разделенных точками, например 
123.123.123.123. 

- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings >E-mail/FTP Settings >E-mail Settings. 

3. Введите необходимую информацию и нажмите Submit. 

Создание ярлыка быстрого доступа для E-mail 

Создание ярлыка быстрого доступа для E-mail с помощью встроенного веб-
сервера 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера. 

Примечания: 

- Посмотрите IP-адрес принтера в разделе TCP/IP меню "Network/Ports". IP-адрес 
отображается в виде четырех наборов цифр, разделенных точками, например 
123.123.123.123. 
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- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings >Manage Shortcuts >E-mail Shortcut Setup. 

3. Задайте имя ярлыка быстрого доступа и введите адрес E-mail. 

Обратите внимание: При вводе нескольких адресов разделяйте их запятыми. 

4. При необходимости настройте параметры сканирования. 

5. Введите номер быстрого доступа и нажмите Add. 

Если вы введете уже используемый номер, то вам будет предложено выбрать другой. 

Отмена E-mail 

На панели управления принтера нажмите . 
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6—Работа с факсами 
Отправка факса 

Отправка факса с панели управления принтера 

1. Загрузите оригинальный документ лицевой стороной вверх, короткой стороной вперед в лоток
АПД или лицевой стороной вниз на стекло сканера.

Примечания:

- Не загружайте в лоток АПД открытки, фотографии, прозрачные пленки, фотобумагу и
тонкие носители (например, вырезки из журналов). Размещайте их на стекле сканера. 

- Если бумага загружена правильно, загорается индикатор АПД. 

2. При загрузке документа в лоток АПД отрегулируйте положение направляющих для бумаги.

3. На панели управления принтера перейдите к:

 >Fax >  > введите факс или номер быстрого доступа на клавиатуре >  >Original 

Size >  

Обратите внимание: если вы хотите отправить по факсу другой документ, то положите его на 
стекло сканера, нажмите на кнопку с левой или правой стрелкой для перехода к Scan the Next 

Page и нажмите . 

4. Нажмите на кнопку с левой или правой стрелкой для перехода к Finish the Job и нажмите . 

Отправка факса с помощью компьютера 

Данная опция драйвера принтера позволяет отправить задание на печать на принтер, который 
затем отправляет это задание в виде факса. Данная опция действует как обычный факсовый 
аппарат, но при этом управление осуществляется через драйвер принтера, а не панель 
управления принтера. 

1. Когда документ открыт, нажмите File >Print.

2. Выберите принтер и нажмите Properties, Preferences, Options или Setup.

3. Перейдите к:

вкладка Fax >Enable fax

4. В поле "Fax number(s)" введите номер (или номера) получателя.

Примечание: номера факсов можно вводить вручную или с помощью приложения
"Телефонная книга"

5. При необходимости в поле "Dialing prefix" введите префикс.
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6. Выберите соответствующий формат бумаги и ориентацию страницы. 

7. Если вы также хотите отправить страницу обложки, то выберите Include cover page with fax и 
введите соответствующую информацию. 

8. Нажмите OK. 

Примечания: 

• Подробнее об установке этих драйверов см. диск Drivers and Documentation. 

• Если поставлен флажок Always display settings prior to faxing, то перед отправкой факса вам 
будет предложено подтвердить информацию о получателе. Если флажок не стоит, то 
находящийся в очереди документ будет отправлен автоматически при нажатии OK на вкладке 
"Fax". 

Отправка факса с помощью номера быстрого доступа 

Ярлыки быстрого доступа для факса напоминают номера быстрого набора на телефоне или 
факсовом аппарате. Номер быстрого доступа (1–999) может содержать одного или несколько 
получателей. 

1. Загрузите оригинальный документ лицевой стороной вверх, короткой стороной вперед в лоток 
АПД или лицевой стороной вниз на стекло сканера. 

Примечания: 

- Не загружайте в лоток АПД открытки, фотографии, прозрачные пленки, фотобумагу и 
тонкие носители (например, вырезки из журналов). Размещайте их на стекле сканера. 

- Если бумага загружена правильно, загорается индикатор АПД. 

2. При загрузке документа в лоток АПД отрегулируйте положение направляющих для бумаги. 

3. Нажмите # и с клавиатуры введите номер быстрого доступа. 

4. Нажмите . 

Отправка факса с помощью адресной книги 

Функция адресной книги позволяет искать закладки и сервера с сетевыми папками. 

1. Загрузите оригинальный документ лицевой стороной вверх, короткой стороной вперед в лоток 
АПД или лицевой стороной вниз на стекло сканера. 

Примечания: 

- Не загружайте в лоток АПД открытки, фотографии, прозрачные пленки, фотобумагу и 
тонкие носители (например, вырезки из журналов). Размещайте их на стекле сканера. 

- Если бумага загружена правильно, загорается индикатор АПД. 

2. При загрузке документа в лоток АПД отрегулируйте положение направляющих для бумаги. 
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3. На панели управления принтера перейдите к: 

 >Fax >  >  > выберите имя получателя >  

Отправка факса в заданное время 

1. Загрузите оригинальный документ лицевой стороной вверх, короткой стороной вперед в лоток 
АПД или лицевой стороной вниз на стекло сканера. 

Примечания: 

- Не загружайте в лоток АПД открытки, фотографии, прозрачные пленки, фотобумагу и 
тонкие носители (например, вырезки из журналов). Размещайте их на стекле сканера. 

- Если бумага правильно загружена в лоток АПД, загорается индикатор АПД. 

2. При загрузке документа в лоток АПД отрегулируйте положение направляющих для бумаги. 

3. На панели управления принтера перейдите к: 

 >Fax >  > введите номер факса >Delayed Send >Send Later > выберите дату отправки 

факса >  > выберите время отправки факса >  

4. Нажмите . 

Примечание: документ сканируется и отправляется по факсу в заданное время. 

Создание ярлыка получателя факса 

Создание ярлыка получателя факса с помощью встроенного веб-сервера 

Можно установить номер быстрого доступа для одного номера факса или для группы номеров. 

1. Откройте веб-браузер и в адресной строке введите IP-адрес принтера. 

Примечания: 

- Посмотрите IP-адрес принтера в разделе TCP/IP меню "Network/Ports". IP-адрес 
отображается в виде четырех наборов цифр, разделенных точками, например 
123.123.123.123. 

- Если используется прокси-сервер, временно отключите его, чтобы обеспечить правильную 
загрузку веб-страницы. 

2. Нажмите Settings > Manage Shortcuts > Fax Shortcut Setup. 

Примечание: может потребоваться пароль. Если у вас нет ID и пароля, обратитесь к 
специалисту службы поддержки. 
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3. Задайте имя ярлыка быстрого доступа и введите номер факса. 

Примечания: 

- Чтобы создать ярлык быстрого доступа для нескольких номеров, введите номера факса 
для группы. 

- Номера факсов в группе разделяйте точкой с запятой (;). 

4. Задайте номер быстрого доступа. 

Примечание: если вы ввели номер, который уже используется, вам будет предложено 
выбрать другой номер. 

5. Нажмите Add. 

Отмена исходящего факса 

Отмена отправки факса во время сканирования оригинальных документов 

• Если вы используете лоток АПД и появляется Scanning page, то нажмите . 

• Если вы используете стекло сканера и появляется Scanning page, Scan the Next Page 

или Finish the Job, то нажмите . 

Отмена отправки факса после сканирования оригинальных документов 

1. На панели управления принтера нажмите . 

2. Нажмите на кнопку с левой или правой стрелкой для перехода к заданию, которое вы хотите 
отменить. 

3. Нажмите  >Delete Selected Jobs. 
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7—Сканирование 
Сканирование на адрес FTP 

Сканирование на адрес FTP 

Сканирование на адрес FTP с помощью номера быстрого доступа 

1. Загрузите оригинальный документ лицевой стороной вверх, короткой стороной вперед в лоток 
АПД или лицевой стороной вниз на стекло сканера. 

Примечания: 

- Не загружайте в лоток АПД открытки, фотографии, прозрачные пленки, фотобумагу и 
тонкие носители (например, вырезки из журналов). Размещайте их на стекле сканера. 

- Если бумага загружена правильно, загорается индикатор АПД. 

2. При загрузке документа в лоток АПД отрегулируйте положение направляющих для бумаги. 

3. На панели управления принтера нажмите # и введите номер быстрого доступа к FTP. 

4. Нажмите . 

Сканирование на адрес FTP с использованием адресной книги 

1. Загрузите оригинальный документ лицевой стороной вверх, короткой стороной вперед в лоток 
АПД или лицевой стороной вниз на стекло сканера. 

Примечания: 

- Не загружайте в лоток АПД открытки, фотографии, прозрачные пленки, фотобумагу и 
тонкие носители (например, вырезки из журналов). Размещайте их на стекле сканера. 

- Если бумага загружена правильно, загорится индикатор ADF. 

2. При загрузке документа в лоток АПД отрегулируйте положение направляющих для бумаги. 

3. На панели управления принтера перейдите к: 

 >FTP Shortcuts >  > выберите имя получателя >  
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8—Удаление застрявшей бумаги 
На дисплее принтера появляются сообщения о застревании бумаги с указанием области, в 
которой оно произошло. Если застреваний несколько, отображается количество застрявших 
страниц. 

Предотвращение застревания бумаги 
Правильно загружайте бумагу 

• Убедитесь, что бумага в лотке лежит ровно. 

Правильная загрузка бумаги Неправильная загрузка бумаги 

  

  

• Не извлекайте лоток во время выполнения печати. 

• Не загружайте лоток во время выполнения печати. Загружайте его до печати или дождитесь 
предложения загрузки. 

• Не загружайте слишком большое количество бумаги. Убедитесь, что стопка ниже индикатора 
максимального количества бумаги. 
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• Не задвигайте бумагу в лоток. Загружайте бумагу, как показано на иллюстрации. 

 

• Убедитесь, что направляющие лотка или многофункционального податчика расположены 
правильно и не слишком плотно прижаты к бумаге или конвертам. 

• После загрузки бумаги плотно вставьте лоток в принтер. 

Используйте рекомендуемую бумагу 

• Используйте только рекомендуемую бумагу или специальные носители. 

• Не загружайте мятую, влажную или скрученную бумагу. 

• Перед загрузкой изогните, пролистайте и выпрямите бумагу. 

 

• Не используйте бумагу, обрезанную вручную. 

• Не смешивайте в одном лотке бумагу разных форматов, типов или плотности. 

• Проверьте правильность задания настроек типа и формата бумаги на компьютере или панели 
управления принтера. 

• Храните бумагу согласно рекомендациям производителя. 

Сообщения о застревании бумаги и места застревания 
При застревании бумаги на дисплее принтера появляется сообщение, указывающее на место 
застревания и содержащее инструкции по удалению застрявшей бумаги. Для удаления 
застрявшей бумаги откройте дверцы, крышки и лотки, указанные на дисплее. 
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Примечания: 

• Если включена функция Jam Assist (Помощь при застревании бумаги), то после удаления 
застрявшей страницы принтер автоматически выводит пустые страницы или страницы, 
отпечатанные частично, в стандартный накопитель. Проверьте выходной лоток на наличие 
отбракованных страниц. 

• Если функция Jam Recovery (Восстановление при застревании бумаги) включена или 
выполняется автоматически, то принтер повторно печатает застрявшие страницы. Однако, 
автоматическая настройка не гарантирует, что страницы будут напечатаны повторно. 

 

  Область, где 
застряла бумага 

Сообщение на панели
управления принтера 

Действия по устранению 

1 Автоподатчик 
документов (АПД) 

[x]-page jam, open automatic feeder 
top cover. [28y.xx] (Застревание  
[x]-страницы, откройте верхнюю 
крышку автоматического 
податчика. [28y.xx]) 

Выньте всю бумагу из лотка АПД и 
извлеките застрявшую бумагу. 

2 Стандартный 
накопитель 

[x]-page jam, clear standard 
bin. [20y.xx] (Застревание  
[x]-страницы, очистите 
стандартный накопитель. [20y.xx]) 

Выньте застрявшую бумагу. 

3 Передняя дверца [x]-page jam, open front 
door. [20y.xx] (Застревание 
[x]-страницы, откройте переднюю 
дверцу. [20y.xx]) 

Откройте переднюю дверцу, затем 
извлеките картридж с тонером и 
узел формирования изображений, 
затем выньте застрявшую бумагу. 

4 Многофункциональный 
податчик 

[x]-page jam, clear manual 
feeder. [25y.xx] (Застревание 
[x]-страницы, очистите ручной 
податчик. [25y.xx]) 

Выньте всю бумагу из 
многофункционального податчика 
и извлеките застрявшую бумагу. 
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Область, где 
застряла бумага 

Сообщение на панели
управления принтера 

Действия по устранению 

5 Лоток 1 [x]-page jam, remove tray 1 to clear 
duplex. [23y.xx] (Застревание 
[x]-страницы, извлеките лоток 1 
для очистки дуплексного 
устройства. [23y.xx]) 

Полностью выдвиньте лоток 1, 
затем потяните вниз переднее 
ушко дуплексного устройства и 
извлеките застрявшую бумагу. 

Примечание: чтобы удалить 
застрявшую бумагу 23y.xx, вам 
может потребоваться открыть 
заднюю дверцу. 

6 Лоток [x] [x]-page jam, remove tray 
[x]. [24y.xx] (Застревание  
[x]-страницы, извлеките лоток 
[x]. [24y.xx]) 

Выньте указанный лоток и 
извлеките застрявшую бумагу. 

7 Задняя дверца [x]-page jam, open rear 
door. [20y.xx] (Застревание 
[x]-страницы, откройте заднюю 
дверцу. [20y.xx]) 

Откройте заднюю дверцу и выньте 
застрявшую бумагу. 

[x]-page jam, open front door. [20y.xx] 

 ПРЕДОСТЕРЕЖЕНИЕ. ГОРЯЧАЯ ПОВЕРХНОСТЬ: внутренние компоненты принтера могут 
быть горячими. Для снижения риска получения травм от горячих компонентов дайте поверхности 
остыть. 

1. Нажмите кнопку с правой стороны принтера и откройте переднюю дверцу.

35

копиры��— �принтеры��— �мфу доставка��—�сервис��—�гарантия info@km-shop.ru www.km-shop.ru(495) 646-04-26



Краткое руководство 

 
- 36 - 

2. С помощью рукоятки извлеките картридж с тонером. 

 

3. Поднимите синюю ручку и извлеките из принтера узел формирования изображений. 

 

Предупреждение. Возможность повреждения: не касайтесь голубого барабана с 
фотопроводящим слоем, расположенного под узлом формирования изображений. Это может 
повлиять на качество выполнения заданий на печать. 

 

4. Поместите узел формирования изображений на гладкую и ровную поверхность. 

Предупреждение. Возможность повреждения: не подвергайте узел формирования 
изображений воздействию прямых солнечных лучей более 10 минут. Длительное воздействие 
прямого солнечного света может ухудшить качество печати. 
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5. Поднимите зеленое ушко перед принтером. 

 

6. Крепко сожмите застрявшую бумагу с обеих сторон и осторожно вытащите. 

Примечание: убедитесь, что удалены все фрагменты бумаги. 
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7. Вставьте узел формирования изображений, совместив стрелки на боковых направляющих узла 
со стрелками на боковых направляющих внутри принтера, затем вставьте узел формирования 
изображений в принтер. 

 

8. Вставьте картридж с тонером, совместив стрелки на боковых направляющих картриджа со 
стрелками на боковых направляющих внутри принтера, затем вставьте картридж с тонером в 
принтер. 

 

9. Закройте переднюю дверцу. 
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[x]-page jam, open rear door. [20y.xx] 
1. Откройте переднюю дверцу, чтобы ослабить застрявшую в задней дверце бумагу. 

 

2. Осторожно потяните заднюю дверцу вниз. 

 ПРЕДОСТЕРЕЖЕНИЕ. ГОРЯЧАЯ ПОВЕРХНОСТЬ: внутренние компоненты принтера 
могут быть горячими. Для снижения риска получения травм от горячих компонентов дайте 
поверхности остыть. 
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3. Крепко сожмите застрявшую бумагу с обеих сторон и осторожно вытащите. 

Примечание: убедитесь, что удалены все фрагменты бумаги. 

 

4. Закройте заднюю дверцу, затем переднюю дверцу. 

[x]-page jam, clear standard bin. [20y.xx] 
1. Крепко сожмите застрявшую бумагу с обеих сторон и осторожно вытащите. 

Примечание: убедитесь, что удалены все фрагменты бумаги. 
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[x]-page jam, remove tray 1 to clear duplex. [23y.xx] 

 ПРЕДОСТЕРЕЖЕНИЕ. ГОРЯЧАЯ ПОВЕРХНОСТЬ: внутренние компоненты принтера могут 
быть горячими. Для снижения риска получения травм от горячих компонентов дайте поверхности 
остыть. 

1. Полностью выдвиньте лоток из принтера.

2. Найдите зеленый рычажок и потяните его вниз, чтобы ослабить застрявшую бумагу.
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3. Крепко сожмите застрявшую бумагу с обеих сторон и осторожно вытащите. 

Примечание: убедитесь, что удалены все фрагменты бумаги. 

 

4. Вставьте лоток. 

[x]-page jam, open tray [x]. [24y.xx] 
1. Полностью выдвиньте лоток из принтера. 

Примечание: в этом сообщении на дисплее принтера указывается лоток, в котором застряла 
бумага. 
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2. Крепко сожмите застрявшую бумагу с обеих сторон и осторожно вытащите.

Примечание: убедитесь, что удалены все фрагменты бумаги.

3. Вставьте лоток.

[x]-page jam, clear manual feeder. [25y.xx] 
1. В многофункциональном податчике крепко сожмите застрявшую бумагу с обеих сторон и

осторожно вытащите.

Примечание: убедитесь, что удалены все фрагменты бумаги.

2. Изогните листы бумаги вперед и назад, чтобы предотвратить слипание, а затем пролистайте.
Не складывайте и не мните бумагу. Подровняйте края на ровной поверхности.
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3. Снова загрузите бумагу в многофункциональный податчик.

Примечание: убедитесь, что направляющая немного упирается в край бумаги. 

[x]-page jam, open automatic feeder top cover. [28y.xx] 
1. Извлеките все оригинальные документы из лотка АПД.

Примечание: сообщение удаляется при извлечении всех страниц из лотка АПД.

2. Откройте крышку АПД.

3. Крепко сожмите застрявшую бумагу с обеих сторон и осторожно вытащите.

Примечание: убедитесь, что удалены все фрагменты бумаги.

4. Закройте крышку АПД.

5. Выпрямите края оригиналов, затем загрузите документы в АПД и отрегулируйте положение
направляющей.

Ïÿòûé ïàðòíåð     info@km-shop.ru  8 (800) 555-16-46          8 (495) 646-04-26         www.km-shop.ru
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